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Abstract

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) Trunking between service provider Rogers Business Solutions and Avaya IP Office 8.1.

Rogers Business Solutions SIP Trunking provides PSTN access via a SIP trunk between the
enterprise and the Rogers Business Solutions network as an alternative to legacy analog or
digital trunks. This approach generally results in lower cost for the enterprise.

Rogers Business Solutions is a member of the Avaya DevConnect Service Provider program.
Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the procedures for configuring Session Initiation Protocol (SIP)
Trunking between service provider Rogers Business Solutions and an Avaya IP Office solution. In
the sample configuration, the Avaya IP Office solution consists of an Avaya IP Office 500v2
Release 8.1, Avaya Voicemail Pro, Avaya IP Office Softphone, and Avaya H.323, digital and analog
endpoints.

The Rogers Business Solutions SIP Trunking service referenced within these Application Notes is
designed for business customers. The service enables local and long distance PSTN calling via
standards-based SIP trunks as an alternative to legacy analog or digital trunks, without the need for
additional TDM enterprise gateways and the associated maintenance costs.

2. General Test Approach and Test Results

The general test approach was to configure a simulated enterprise site using Avaya IP Office to
connect to Rogers Business Solutions SIP Trunking service. This configuration (shown in Figure 1)
was used to exercise the features and functionality tests listed in Section 2.1.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent to
the interoperability of the tested products and their functionalities. DevConnect Compliance Testing
is not intended to substitute full product performance or feature testing performed by DevConnect
members, nor is it to be construed as an endorsement by Avaya of the suitability or completeness of
a DevConnect member’s solution.

2.1. Interoperability Compliance Testing

A simulated enterprise site with Avaya IP Office was connected to Rogers Business Solutions SIP
Trunking service. To verify SIP trunking interoperability, the following features and functionality
were exercised during the interoperability compliance test:

* Incoming PSTN calls to various phone types. Phone types included H.323, digital, and
analog telephones at the enterprise. All inbound PSTN calls were routed to the enterprise
across the SIP trunk from the service provider.

*  QOutgoing PSTN calls from various phone types. Phone types included H.323, digital, and
analog telephones at the enterprise. All outbound PSTN calls were routed from the
enterprise across the SIP trunk to the service provider.

* Inbound and outbound PSTN calls to/from the Avaya IP Office Softphone.

* Inbound and outbound long hold time call stability.

* Various call types including: local, long distance, international, outbound toll-free; 411 and
911 services.

* Codec G.711U and G.711A.

+ (aller number/ID presentation.

Privacy requests (i.e., caller anonymity) and Caller ID restriction for inbound and outbound
calls.

* DTMF transmission using RFC 2833.
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Voicemail navigation for inbound and outbound calls.

Telephony features such as hold and resume, transfer, and conference.

Use of SIP re-INVITE for call transfer to PSTN.

FAX T.38.

Off-net call forwarding (Rogers Business Solutions supports Diversion Header)
Twinning to mobile phones on inbound calls.

> 2 % » » »

2.2. Test Results

All the applicable test cases were executed. However, the following observations were noted during
the compliance testing:

1. Rogers Business Solutions network did not support Operator Assisted Calls.

2. The Rogers Business Solutions 911 service was simulated to route the call to a PSTN
number.

3. For outbound calls with privacy (anonymous) enabled, Avaya IP Office replaced the calling
party number in the From and Contact headers of the SIP INVITE message with “restricted”
and “anonymous” respectively and enabled Privacy:id. On the other hand, by default, Avaya
I[P Office sent the P-Preferred-Identity (PPI) or configured to send P-Asserted-Identity (PAI)
header to pass the actual calling party information for authentication and billing. Rogers
Business Solutions made some adjustments on configuration to affect the behavior as
expected. (Note: Rogers Business Solutions system does not use either PPI or PAI for the
purposes of privacy).

4. The inbound toll free is not supported since this test case only verifies the generic toll free
service and translation/routing function. It is not significant to the interoperability between
Avaya IP Office and our SIP Trunk service.

5. Rogers Business Solutions does not support register and authentication.

It was agreed with Rogers Business Solutions that the above observations were not severe enough to
fail the testing. Rogers Business Solutions SIP Trunking passed compliance testing.

2.3. Support

For technical support on the Avaya products described in these Application Notes visit:
http://support.avaya.com.

For technical support on the Rogers Business Solutions system, please contact customer service or
visit http://www.rogersbusinesssolutions.com/sip-trunking/

3. Reference Configuration

Figure 1 below illustrates the test configuration. The test configuration shows an enterprise site
connected to Rogers Business Solutions SIP Trunking service through the public IP network. For
confidentiality and privacy purposes, actual public IP addresses used in this testing have been
masked out and replaced with fictitious IP addresses throughout the document.

Located at the enterprise site is an Avaya IP Office 500v2 with the MOD DGTL STA16 expansion
module which provides connections for 16 digital stations to the PSTN, and the extension PHONE 8
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card which provides connections for 8 analog stations to the PSTN as well as 64-channel VCM
(Voice Compression Module) for supporting VoIP codecs. The Voicemail Pro service runs on the IP
Office UC Module. The LAN port of Avaya IP Office is connected to the enterprise LAN while the
WAN port is connected to the public IP network. Endpoints include an Avaya 9600 Series IP
Telephone (with H.323 firmware), Avaya 1408D Digital Telephones, an Avaya Symphony 2000
Analog Telephone and an Avaya IP Office Softphone H323. A separate Windows XP PC runs
Avaya [P Office Manager to configure and administer Avaya IP Office.

Mobility Twinning is configured for some of the Avaya IP Office users so that calls to these user’s
phones will also ring and can be answered at the configured mobile phones.

10.10.97.X 0

Avaya IP Office500 V2
Release 8.1 q
Voicemail Pro

P Office  IP Office
Softphone ~ Manager

Avaya 9600 Series IP Phones (H323)
Analog

FAX Digital
Phone Phone ﬁ ﬁ
97 \ \

( 10.10.98.X 0

DevConnect Test LAB

Enterprise site

Session Border Controller Service Provider
Acme Packet NetNet 6.2

192.16831.194

Rogers
Communications
Network Cloud

Internet

4

-/ Mobile

twining

with Cell

Digital Phone FAX

Figure 1: Test Configuration for Avaya IP Office with Rogers Business Solutions SIP
Trunking Service

For the purposes of the compliance test, Avaya IP Office users dialed a short code of 9 + N digits to
send digits across the SIP trunk to Rogers Business Solutions. The short code of 9 was stripped off
by Avaya IP Office but the remaining N digits were sent unaltered to Rogers Business Solutions. For
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calls within the North American Numbering Plan (NANP), the user would dial 11 (1 + 10) digits.
Thus for these NANP calls, Avaya IP Office would send 11 digits in the Request URI and the To
field of an outbound SIP INVITE message. It was configured to send 10 digits in the From field. For
inbound calls, Rogers Business Solutions SIP Trunking sent 10 digits in the Request URI and the To
field of inbound SIP INVITE messages.

In an actual customer configuration, the enterprise site may also include additional network
components between the service provider and the Avaya IP Office such as a session border
controller or data firewall. A complete discussion of the configuration of these devices is beyond the
scope of these Application Notes. However, it should be noted that SIP and RTP traffic between the
service provider and the Avaya IP Office must be allowed to pass through these devices.

4. Equipment and Software Validated

The following equipment and software/firmware were used for the sample configuration provided:

Avaya Telephony Components
Equipment Release
Avaya IP Office 500v2 8.1(43)
Avaya IP Office DIG DCP*16 V2 8.1(43)
Avaya IP Office Ext Card Phone 8 8.1
Avaya [P Office Manager 10.1 (43)
Avaya 9640 IP Telephone (H.323) Avaya one-X Deskphone Edition S3.110b
Avaya Digital Telephones (1408D) N/A
Avaya Symphony 2000 Analog N/A
Telephone
Avaya IP Office Softphone 3.2.3.15 64595
Rogers Business Solutions Components
Equipment Release
SBC Acmepacket Net-Net 6.2
RBS Sip Core 2.5.9130122
Gateway = AudioCode M5k 6.1

Note: Testing was performed with IP Office 500 R8.1, but it also applies to IP Office Server Edition
R&8.1. Note that IP Office Server Edition requires an Expansion IP Office 500 v2 R8.1 to support
analog or digital endpoints or trunks.

5. Configure IP Office

This section describes the Avaya IP Office configuration to support connectivity to Rogers Business
Solutions SIP Trunking service. Avaya IP Office is configured through the Avaya IP Office
Manager PC application. From a PC running the Avaya IP Office Manager application, select Start
- Programs - IP Office > Manager to launch the application. Navigate to File > Open
Configuration, select the proper Avaya IP Office system from the pop-up window, and log in with
the appropriate credentials. A management window will appear similar to the one shown in the next
section. The appearance of the IP Office Manager can be customized using the View menu. In the
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screens presented in this section, the View menu was configured to show the Navigation pane on the
left side, the Group pane in the center, and the Details pane on the right side. These panes will be
referenced throughout the Avaya IP Office configuration. Proper licensing as well as standard
feature configurations that are not directly related to the interface with the service provider (such as
the LAN interface to the enterprise site and IP Office Softphone support) is assumed to be already in
place.

5.1. LAN2 Settings

In the sample configuration, the IPOffice 1 was used as the system name and the WAN port was
used to connect the Avaya IP Office to the public network. The LAN2 settings correspond to the
WAN port on the Avaya IP Office. To access the LAN2 settings, first navigate to System (1) >
IPOffice_1 in the Navigation and Group Panes and then navigate to the LAN2-> LAN Settings tab
in the Details Pane. Set the IP Address field to the IP address assigned to the Avaya IP Office
WAN port. Set the IP Mask field to the mask used on the public network. All other parameters
should be set according to customer requirements.

i ] Avaya IP Office RB.1 Manager [POffice_1 [8.1(43)] [Administrator{Administrator)]

File Edt Wiew Tools Help

IP Offices System B IPOffice_1 o -8 X v« |
-& BoOTR(7) Sz System | Lan1 |[L8M2 | |ons | woicemai | Telephony | Directory Services | System Events | sMTR | SMOR | Twinnin g |vem | ccr | Codecs
{5 Operatar (3) “IPOFfice_1 e = L 1 - 4 . =
o |[at Settings] | vt | network Tapology | S1P Registrar
L 1P ddress [10 10 s 14|
% Control Unit (4) 1P Mask 255 . 255 255 . 192
& Extension (40) - =
& User(33) Primary Trans. IP Address ] 0 o o |
3§ Huntroup (1)
9% Short Code (57) Firewall Profile =None >
B service () RIP Mode [hane -
A RAS 1) s
4P Incoming Call Route (3) [ Enable naT
¥ wanPort (D) ; —
e Doy Mumber Of DHCP IP Addresses (200 5
£33 Time Profile (0) DHCP Mode
% ;r;”;:!;g;"e w O server O client O Disin &) Disabled
&m fccount Code (D)
S, Licerse (30)
& Tunnel (0)
5 User Rights (10
@ Auto Attendant ()
AR (2)
fx 311 System (1)
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Select the VoIP tab as shown in the following screen. The H323 Gatekeeper Enable box is checked
to allow the use of Avaya IP Telephones using the H.323 protocol, such as the 9600-Series IP
Telephones used in the sample configuration. The SIP Trunks Enable box must be checked to
enable the configuration of SIP trunks to Rogers Business Solutions. The SIP Registrar Enable box
is checked to allow Avaya IP Office Softphone usage. The RTP Port Number Range can be
customized to a specific range of receive ports for the RTP media. Based on this setting, Avaya IP
Office would request RTP media be sent to a UDP port in the configurable range for calls using
LAN2. Avaya IP Office can also be configured to mark the Differentiated Services Code Point
(DSCP) in the IP Header with specific values to support Quality of Service policies for both
signaling and media. The DSCP field is the value used for media and the SIG DSCP is the value
used for signaling. The specific values used for the compliance test are shown in the example
below. All other parameters should be set according to customer requirements.

Ei IPOffice_1* of - B %X | v <[]

System || LANL | LANZ DS | Woicemail | Telephony | Directory Services || System Events | SMTP | SMDR || Twinning | ¥CM || CCR | Codecs

LAMN Settings f | Metwaork Topalagy | SIP Registrar

H.323 Gatekeeper Enable
SIP Trunks Enable
SIP Registrar Enable

RTP Port Mumber Range

H.323 Auko-create Extn e
Port Range (Minimum) (49152

|

H.323 Auto-create User Port Range (Maximum) 53246

[] H.323 Remate Extn Enable

Enable RTCP Manitaring
©n Pork 5005

DiffSery Settings

B8 % DScPHexy FC | DSCP Mask (Hex) |88 516 DSCP (Hex)

o (4
[ECET

%6 3_ DSCP B3 | DSCP Mask 3¢ 516 DSCP
DHCP Settings
Primary Site Specific Option Mumber (S30OMN) 178 3
Secondary Sike Specific Option Murnber (S50M) |24z I 3_1;
i (ot resent |
1100 Yoice YLAN Site Specific Option Number (S50M) (232 =
1100 Yoice YLAN IDs
! v
0K ] [ Cancel ] I Help
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On the Network Topology tab in the Details Pane, configure the following parameters:

*+ Select the Firewall/NAT Type from the pull-down menu that matches the network
configuration. No firewall or network address translation (NAT) device was used in the
compliance test as shown in Figure 1, so the parameter was set to Open Internet. With this
configuration, STUN will not be used.

* Set the Binding Refresh Time (seconds) to 60. This value is used as one input to determine
the frequency at which Avaya IP Office will send SIP OPTIONS messages to the service
provider. See Section 5.10 for complete details.

+ Set Public IP Address to the [P address of the Avaya IP Office WAN port. Public Port is
set to 5060.

* All other parameters should be set according to customer requirements.

Ej IPOffice_1*

System | LAN1 | Lamz |DMS || Voicemail | Telephony | Directory Services | Syskem Events | SMTP | SMDR. | Twinning | ¥CM | CCR | Codecs

LAN Settings | VoIP | Network Topology | | STP Registrar |

Metwork Topalogy Discovery

STUM Server IP Address 19z . 165 .« 10 . 13 | STUNPort  [3478 &
FirewallfNAT Type EOpen Internet » |

Binding Refresh Time 6o Y |

(seconds) = |

Public IP Address [10 . 10 . 28 . 14 |

Public Part :505':' 5 | Rur STUM Cancel

] Rum STUM on skartup

In the compliance test, the LANT1 interface was used to connect the Avaya IP Office to the enterprise
site IP network. The LANI1 interface configuration is not directly relevant to the interface with
Rogers Business Solutions SIP Trunking service, and therefore is not described in these Application
Notes.
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5.2. System Telephony Settings

Navigate to the Telephony - Telephony Tab in the Details Pane. Choose the Companding Law
typical for the enterprise location. For North America, U-Law is used. Uncheck the Inhibit Off-
Switch Forward/Transfer box to allow call forwarding and call transfers to the PSTN via the
service provider across the SIP trunk.

—

Telephony || Tones & Music | Call Log

Analogue Extensions
Defaulk Outside Call Sequence
Default Inside Call Sequence

Default Ring Back Sequence

Restrict Analogue Extension Ringer Yoltage

| Call Priority Promotion Time {secs)  Disabled

Dial Delay Time (secs) B |
Dial Delay Count D " 37
Default Mo Answer Time {secs) s [
Hold Timeout (secs) 120 :’
Park Timeout {secs) 300 37:
Ring Delay {secs) 5 :

| Mormal

|Ring Type 1
|Ring Type 2

E|

R

IPOffice_1

| System | LAMN1 || LAMZ | DNS | Vaicemail || Telephany || Directory Services | SystemEvents | SMTP | SMDR | Twinning | vcM || CCR | Codecs

Companding Law|

= Switch Line
25|
= &) U-Law (%) U-Law Line
-

" O A-Law O A-Law Ling

[[] pss status
Auto Hold
Dial By Marne

Show Account Code

‘ [ 1rhibit OFf-Switch Forward Transker

D Restrict Metwork Interconnect

[] brop External Gnky Impromptu Conference

o M %] v <]

Help
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5.3. Twinning Calling Party Settings

When using twinning, the calling party number displayed on the twinned phone is controlled by two
parameters. These parameters only affect twinning and do not impact the messaging or operation of
other redirected calls such as forwarded calls. The first parameter is the Send original calling party
information for Mobile Twinning box on the System—>Twinning tab, as shown below. The
second parameter is the Send Caller ID parameter on the SIP Line form (shown in Section 5.4).

If Send original calling party information for Mobile Twinning on the System—> Twinning tab is
optioned, the setting of the second parameter is ignored and Avaya IP Office will send the following
in the SIP From Header:
*  On calls from an internal extension to a twinned phone, Avaya IP Office will send the calling
party number of the originating extension.
*  On calls from the PSTN to a twinned phone, Avaya IP Office will send the calling party
number of the host phone associated with the twinned destination (instead of the number of
the originating caller).

If this option is unchecked, the value sent in the SIP From header is determined by the setting of the
second parameter mentioned above.

For the compliance test, the Send original calling party information for Mobile Twinning box in
the System—> Twinning tab was checked which overrides any setting of the Send Caller ID
parameter on the SIP Line form.

System | LAML || LAMZ | DNS “oicemail | Telephony | Directory Services | Syskem Events | SMTP | SMOR T:VCM CCR Codecs

| Send ariginal caling party information Far Mabile Twinning |

Calling party information far |
Maobile Twinning
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5.4. Administer SIP Line

A SIP line is needed to establish the SIP connection between Avaya IP Office and Rogers Business
Solutions SIP Trunking service. To create a SIP line, begin by navigating to Line in the left

Navigation Pane, then right-click in the Group Pane and select New = SIP Line. On the SIP Line
tab in the Details Pane, configure the parameters as shown below:

Set ITSP Domain Name to the enterprise domain so that [P Office uses this domain as the
host portion of the SIP URI in SIP headers such as the From header.

Set Send Caller ID to Diversion Header. For the compliance test, this parameter was used

for call forwarding and it was ignored in Mobility Twinning since Send original calling

party information for Mobile Twinning is optioned in Section 5.3.

*  Check the In Service box.
*  Check the Check OOS box. With this option selected, IP Office will use the SIP OPTIONS

method to periodically check the SIP Line.

* Default values may be used for all other parameters.

The area of the screen entitled REFER Support is used to enable/disable SIP REFER for call
transfers. The default values of “Auto” for Incoming and Outgoing effectively disable the use of

SIP REFER.

& BoOTP ()
{7 Operator {3)
- IPOffics_1

*52 System (1)
e |
2 Conkrol Unit {4
& Extension (40)
g User(zm)
3§ HuntGroup (1)
BX Short Code (57)
B Service (0)
Al RAS (1)
@ Incoming Call Route (9)
g wanport (D)
2 Directory (1)
% Time Profile (0)
@8 Frewall Profile (1)
EH 1P Route (3)
&m Account Code (0)
e, License (30)
@ Tunnel (D)
£ User Rights (10
188 Auto Attendant (0)
¥ ARS (2)
= E911 System (1)

IP Offices Line

Line Kumber | Line Type Line SthType

w1 PRI 24 {Universal) T1

2 PRI 24 {Universal} T1
.17 SIP Line

SIP Line - Line 17

(|52 Une] rransport|stP LRI vaIP |38 Fax | SIP Credentials

Line Humber 17 =

‘ IT5P Domain Mame | 10.10.98.14

| In Service:

Prefix
Natiorial Prefix
Country Code

Inkernational Prefix |

Send Caller ID Diversion Header

Association Method | By Source IF address

Use Tel URT
Check 005

Call Routing Method

Originator number for
Farwarded and bwinring calls

Mame Priarity
Caller 1D from From header

Send From In Clear

User-Agent and Server
Headers

REFER Suppart
Incoming |auto

Outgaing |Auto

UPDATE Supported | Never

Request URT

System Defauk
O

ef B X v <>
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Select the Transport tab. The ITSP Proxy Address is set to the Rogers Business Solutions SIP
proxy gateway (Session Border Controller Acme Packet Net-Net) [P Address provided by Rogers
Business Solutions. As shown in Figure 1, this [P Address is 192.168.31.194. In the Network
Configuration area, UDP is selected as the Layer 4 Protocol, and the Send Port is set to the port
number provided by Rogers Business Solutions, in this case the well known SIP port of 5060 was
used. The Use Network Topology Info parameter is set to LAN 2. This associates the SIP Line with
the parameters in the System - LAN2 - Network Topology tab. Other parameters retain default
values in the screen below.

IP Offices Line B SIP Line - Line 17
K BoOTP (7) =t | e Line SUBTYPE || 510 | ine [Transport] st LRt |vatp | T35 Fax|siP Credentials
{# Operator (3) e PRI 24 {Universal) Tl = = =
=5 IPOFfice_L -2 FRI 24 (Universal) T1 | ITSP Proxy Address 192 168.31.194_|
“a# System (1) 17 SIP Line
4 [Line (3) Hetwork Configuration
< Contral Linik {4} r - Faer =

& Extension (40 Lavyer 4 Protocal EU!DP b Send Part [ -
E User (33) Use Metwark Topology Info | LAN 2
ﬁ HunkGroup {13 %
B3¢ Short Code (57) — i i 1
@ Service (0) Explicit DNS Server{s) | a u] a 1) 1L 0 a a a |
ol RAS (1) Calls Route via Reqgistrar
@ Incoming Call Route (9
EE WanPort (0)
o Directory {0} Separate Registrar
£ Time Profile (0}

A SIP URI entry must be created to match each incoming number that Avaya IP Office will accept
on this line. Select the SIP URI tab; click the Add button and the New Channel area will appear at
the bottom of the pane. To edit an existing entry, click an entry in the list at the top, and click the
Edit... button. In the example screen below, a previously configured entry is edited. For the
compliance test, a single SIP URI entry was created that matched any DID number assigned to an
Avaya IP Office user. The entry was created with the parameters shown below:

+ Set Local URI, Contact and Display Name to Internal Data. This setting allows calls on
this line whose SIP URI matches the number set in the SIP tab of any User as shown in
Section 5.6.

*+ Set PAI to Internal Data. With this setting [P Office will populate the SIP P-Asserted-
Identity header on outgoing calls with the data set in the SIP tab of the User initiating the
call, as shown in Section 5.6.

* Associate this line with an incoming line group in the Incoming Group field. This line group
number will be used in defining incoming call routes for this line. Similarly, associate the
line to an outgoing line group using the Outgoing Group field. For the compliance test, a
new incoming and outgoing group 17 was defined that only contains this line (line 17).

*+ Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed using
this SIP URI pattern.
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oIP [ 138 Fax | SIP Credentials

SIP Line -Line 17

Add...

Remove

Edit. ..

Channel | Groups Via | Local URI  Contact Displa_y Mame = PAI Credential =~ Max Calls

1 17 17 155 M... 0:=Non.., 10

Edit Channel

Yia 10.10.98,14

Local URI _|:'-E= Internal Data v |
Conkact 1se Internal Datal Er !
Displaw Mame _I:'-e Internal Daks w !
Pal ficne] v/
Reqistration |I:I: =Mane = b

Incoming Group F?‘—‘

Oukgoing Group |1?"—|

Max Calls per Channel lﬁi

K

HV; Reviewed:
SPOC 4/15/2013

Solution & Interoperability Test Lab Application Notes

©2013 Avaya Inc. All Rights Reserved.

13 of 27
RBSSipTrkIPOS81




Select the VoIP tab to set the Voice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below:

* The Codec Selection can be selected by choosing Custom from the pull-down menu,
allowing an explicit ordered list of codecs to be specified. Selecting G.711 ULAW 64K and
G.711 ALAW 64K codecs causes Avaya [P Office to include these codecs, which are
supported by the Rogers Business Solutions SIP Trunking service, in the Session Description
Protocol (SDP) offer, in that order.

* Set Fax Transport Support to T38 from the pull-down menu.

*+ Set the DTMF Support field to RFC2833 from the pull-down menu. This directs Avaya IP
Office to send DTMF tones using RTP events messages as defined in RFC2833.
*  Uncheck the VoIP Silence Suppression box.
* Check the Re-invite Supported box.
*+  (Check Use Offerer’s Preferred Codec.
*+ Default values may be used for all other parameters.
B g
R BOOTR (7) Line Humber | Line Type Line SUBTYR® || |s1p Line| Transpart| StP URE|VoTP | (738 Fax| 1P Credentials
i+ Operatar (3) 1 PRI 24 (Universal) T1 = — 4
% IPOffice_1 *z PRI 24 (Universal) T1 Codec Selection Custom v]‘ L] valP Sience Suppression
57 System (1) 17 SIP Line - .
.t 7 oo | = ==
e S |
9 User(33) [ codec Lackdown
E ;‘r‘:g‘:fg‘fe((ls)n = [[] PracK{100rel Supparted
4B service (0)
oy RAS (1)
g x?‘rs‘;rf (CESH Route (9) ~
% Directory (0)
£ Time Profile : =
@ l\rew';l\ PFrIuFf\Z)(l) | Fax Transport Suppart T3% b
E i?uuuuntfé:)de (o Call Initiation Timeout {s) |+ i
%, License (30) ‘DTMF Support RFCZE33 ~ |
i Tunnel (D)

Select the T38 Fax tab to set the Fax parameters of the SIP line. Set the parameters as shown below:
*+ Select T38 Fax Version: 0 by choosing from the pull-down menu (This is a requirement of

Rogers Business Solutions).

Check the options: Scan Line Fix-up and TFOP Enhancement.

Set Redundancy Low Speed and High Speed: 0.

Set TCF Method: Trans TCF.

Set Max Bit Rates (bps): 14400.

Set EFlag Start Timer (msecs): 2600.

Set EFlag Stop Timer (msecs): 2300.

Set Tx Network Timout (secs): 150.

> 2 5 > > 5 »
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IP Offices Line E SIP Line - Line 17

"R BOOTR (7 Line Mumber | Line Type Line SUBTYPE || <15 | ine Transpart St URT[votp [T38 Fax|/sip Credentials
{# Operator (3) fl PRI 24 {Universal) T1 . e — E
(=% IPOffice_1 PRI 24 (Unlversal) T1 |T38 Fax Version o » |
25 System (1) "_ 17 SIF Line : 5 Scan Line Fix-up
i T t 2l
4| Line (3} fanspor TFOP Enhancement
=» Control Unit {4) Redundancy
Ay Extension {40} R —i [] Disable T30 ECM
Low Speed |

2 User(33) P E = [] pisable EFlags For First DIS

ﬁ HunkGroup (1)

@ short Code (57) fiiclh o= L | [[] pisable T30 MR, Campression
@ Service (0} TeF Method [Trams TcF [ MsF Override

o RAS (1) :

€9 Incoring Call Route (3) Max Bit Rate (bps) | 14400 v e

£8 wanPart (0) —— — M

i Directory (0} EFlag Start Timer (msecs)  [2600 ' L

£7 Time Profile {09 [

(I i 12300 |
@ Firewaall Profile {13 EFlag Stop Timer (msecs) ...
IP Route (3) Te Metwork Timeout (secs) 5150 el
g Account Code (00 = ==
W License (30)

5.5. Short Code

Define a short code to route outbound traffic to the SIP line. To create a short code, select Short
Code in the left Navigation Pane, then right-click in the Group Pane and select New. On the Short
Code tab in the Details Pane, configure the parameters for the new short code to be created. The
screen below shows the details of the previously administered “9N;” short code used in the test
configuration.

*+ In the Code field, enter the dial string which will trigger this short code, followed by a semi-
colon. In this case, 9N;, this short code will be invoked when the user dials 9 followed by
any number.

*+ Set Feature to Dial. This is the action that the short code will perform.

* Set Telephone Number to N”@public.myrbs.ca”. This field is used to construct the
Request URI and To headers in the outgoing SIP INVITE message. The value N represents
the number dialed by the user. The host part following the “@” is the domain of the service
provider network.

* Set the Line Group Id to the outgoing line group number defined on the SIP URI tab on the
SIP Line in Section 5.4. This short code will use this line group when placing the outbound
call.

*+ Set Locale to United States (US English).

e —
- K& BOOTP (7) Code Telephone Mumber Feature '_
# Operator (3) Bx+g) Forward HuntGroup Calls O | - =

[=-#5p IPOffice_1 - F R Clear Call || Code on;
%y Systemn (1) USRI E N Call Pickup Members Feat ;'D. I. |
e Line (3) ST N Forward Busy Number Fs e :: I?_ e = - '
- = Control Unit {4} BHETONE N Dial Physical Extr by Murnbe Telephone Mumber | M'@public.myrbs, ca” |
- Extension (40) BTN N Dial Physical Extn by Id -
R user(3y) BHHI000%  "MAINTENANCE” Relay On RS {17 |
5 g i Lapdl [iter st (USRI [ |
b @ Service (00 “*QZNJ e et e shaae . Farce Account Code D
o, RAS (1) @MH0ssh " [001S1/ERR - "N Display Msg |
. e Incoming Call Rioute (33 [ snli] "[0151/ERR - "N Display Msg
: @ WanPort (0) L E | "[0351/ERR - "M Display Msg
s Directory (0} .
£ Time Profile (0)
H @ Firewall Profile {13
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The simple “ON;” short codes illustrated above does not provide a means of alternate routing if the
configured SIP Line is out of service or temporarily not responding. When alternate routing options
and/or more customized analysis of the digits following the short code are desired, the Automatic
Route Selection (ARS) feature may be used. In the following example screen, the short code 6N is
illustrated for access to ARS. When the Avaya IP Office user dials 6 plus any number N, rather than
being directed to a specific Line Group Id, the call is directed to Line Group ID 50: Main,
configurable via ARS. See Section 5.8 for example ARS route configuration for 50: Main as well as
a backup route.

W

= ek K| wle<]=
| short Code [

Code (6N |

Feature |_|:Ell5| V!

Telephaone Mumber N |

—
Line Group Id 50: Main v |

Locale | VJ

Force Account Code [
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5.6. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP line
defined in Section 5.4. To configure these settings, first select User in the left Navigation Pane, then
select the name of the user to be modified in the center Group Pane. In the example below, the name
of the user is H323 0401. Select the SIP tab in the Details Pane.

The values entered for the SIP Name and Contact fields are used as the user part of the SIP URI in
the From header for outgoing SIP trunk calls. They also allow matching of the SIP URI for incoming
calls without having to enter this number as an explicit SIP URI for the SIP line (Section 5.4). The
example below shows the settings for user H323 0401. The SIP Name and Contact are set to one of
the DID numbers assigned to the enterprise from Rogers Business Solutions. The SIP Display
Name (Alias) parameter can optionally be configured with a descriptive name. If all calls involving
this user and a SIP Line should be considered private, then the Anonymous box may be checked to
withhold the user’s information from the network.

IP Offices User §

Hame Extension -
R B0OTP (7) Dial In | Yaice Recording | Button Pragramming | Menu Programmin i | Mobility | Phone Manager Options | Hunt Group Membership | Announcement ts Personal | Directory
4 Operator (3) franalog 0404 0404 =

=9 IPOffice 1 & Digital 0409 0409 SIP Mame [+169150401
g Syster (1] FrFax 0407 0407
e i

<2 Contral Unit (4) i
EHaz3 0402 0402 Contact 4169150401
4 Extension (40) ontact

i

3% HunkGroup (1)
B Short Code (56)
@ service (1) @ softphane 0403 0403
o RAS (L) Yoicemail il0415 0415
3 Incoming Call Route (8)

H323 0401: 0401

SIP Display Hame (alias) H323 0401

fmMoUser
frgRemoteManager
&= 0410

[ anonymous

One of the H.323 IP Phones at the enterprise site uses the Mobile Twinning feature. The following
screen shows the Mobility tab for User H323 0401. The Mobility Features and Mobile Twinning
boxes are checked. The Twinned Mobile Number field is configured with the number to dial to
reach the twinned mobile telephone, in this case 916139675205. Other options can be set according
to customer requirements.
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B H323 0401: 0401

| Dial In

| Yoice Recording | Button Programming | Menu Pragramming | Mability EF‘hu:une Manager Options | Hunk Group Membership

[1 trternal Twinning
Twin Bridge Appearances
Twin Coverage Appearances

Twin Line &ppearances

| Mlability: Features|
| Mobile Twinning|

Twinned Maobile Mumber (916139675205
iincluding dial access code) 1707 T

Twinning Time Praofile | <hlone = b4 |
Mobile Dial Delay (secs) !2 !
Mobile Answer Guard (secs) i':' %

[] Hunt group calls eligible Far mobile bwinning
[] Forwarded calls eligible for mobile bwinning
[] Twin When Logged Out
[ one-x Maobile Client
[] Mobile call Contral
robile Callback
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5.7. Incoming Call Route

An Incoming Call Route maps an inbound DID number on a specific line to an internal extension.
This procedure should be repeated for each DID number provided by the service provider. To create
an incoming call route, select Incoming Call Route in the left Navigation Pane, then right-click in
the center Group Pane and select New. On the Standard tab of the Details Pane, enter the
parameters as shown below:

Set the Bearer Capacity to Any Voice.

Set the Line Group Id to the incoming line group of the SIP line defined in Section 5.4.
Set the Incoming Number to the incoming number on which this route should match.
Set Locale to United States (US English).

Default values can be used for all other fields.

» > > » »

IP Offices Incoming Call Route ] 17 4169150401
- & BOOTR(7) Line Group ID | Incoming Mumber | Destination Standard ;Voice Recording || Destinations
(% Operator (3) @D Dialln 7 =
[ #5 IPOffice_1 D17 4169150410 0410 SIP - —
=23 System (1) @17 4169150402 0402 H323 0402 Bearer Capability | Ay Yoice N
T Line (3) @7 4169150401 0401 H323 0401 e = Z
i ) @17 4169150404 0404 Analog 0404 & e =
& Extension {40) 17 4169150403 0403 Saftphane 0403 ||| [Incoming Mumber [4169150401 [
8 User(31) @17 4169150415 YoiceMai
?;‘ ::”ttG?L"jp ((15)3) @17 4169150409 0409 Digital 0409 InEomifg SObpddress
[ald ode
17 4169150407 0407 FAY 0407 ;
@ Service (0) @ Incorning CLI
"i‘é B4 Locale iUnited States (LS English) Sl
@ Priarity [ 1-Low Ll
s Directory (0) =
£ Time Profile (0) Tag
Fi Il Profile {1 r =
B Hold Music Source |System Source ]
g Account Code (0)

On the Destinations tab, select the destination extension from the pull-down menu of the
Destination field. In this example, incoming calls to 416-915-0401 on line 17 are routed to
extension 0401 H323 0401.

IP Offices Incoming Call Route B 17 4169150401 e -8 X v <>
& BooTR (7) Line Group 1D Incoming Mumber | Destination Standard | Volce Recording | Destinations] |
4 Operator (3 0 Diall T = - = -
Lo g ) g” T =l . TmeProfile Destination Falback Extension
%7 System (1) [+-74 4163150402 0402 H323 0402 » Default Yalue 0401 H323 D401 B ~
T Line (3) T+ [ 4169150401 0401 H323 0401 |
<= Cantral Uit (4) D17 4165150404 0404 Analog D404
& Extension (40) (-8 4169150403 0403 Softphone 0403
4 User (31 @17 4169150415 VaiceMail
ﬁ ::"tf?'f “5)3 @17 4163150409 0409 Digital 0403
@ S;:[E:ma =) D17 4160150407 0407 FAY 0407
o, RS (1)
@
&8 Wanport (0
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5.8. ARS and Alternate Routing

While detailed coverage of Automatic Route Selection (ARS) is beyond the scope of these
Application Notes, this section includes basic ARS screen illustrations and considerations. ARS is
shown here mainly to illustrate alternate routing should the SIP Line be out of service or temporarily
not responding.

Optionally, ARS can be used rather than the simple 9N; short code approach documented in Section
5.5. With ARS, a secondary dial tone can be provided after the access code, time-based routing
criteria can be introduced, and alternate routing can be specified so that a call can re-route
automatically if the primary route or outgoing line group is not available. Although not shown in this
section, ARS also facilitates more specific dialed telephone number matching, enabling immediate
routing and alternate treatment for different types of numbers following the access code. For
example, if all 1+10 digit calls following an access code should use the SIP Line preferentially, but
other local or service numbers following the access code should prefer a different outgoing line
group, ARS can be used to distinguish these call behaviors.

To add a new ARS route, right-click ARS in the Navigation pane, and select New. To view or edit
an existing ARS route, select ARS in the Navigation pane, and select the appropriate route name in
the Group pane.

The following screen shows an example ARS configuration for the route named Main. The In
Service parameter refers to the ARS form itself, not the Line Groups that may be referenced in the
form. If the In Service box is un-checked, calls are routed to the ARS route name specified in the
Out of Service Route parameter. [P Office short codes may also be defined to allow an ARS route
to be disabled or enabled from a telephone. The configurable provisioning of an Out of Service
Route, and the means to manually activate the Out of Service Route can be helpful for scheduled
maintenance or other known service-affecting events for the primary route.

IP Offices ARS Ei Main" g -B x| v]=]-
& BooTR(7) Name | Time Profile e
% Operator (3) ¥ backup . =
& 5 POffice_1 “fian | ARS Route 14 7] Secondary Dial tone
= System (1) ] =
4% Line (3) Route Name SystemTone v
Cartral Uit (4)
& Extension (40) Disl Delay Time System Default (4) & Check User Call Barring
& User(3y) 7
3 HuntGroup (1)
9 Short Cods (58) In Service Ok of Service Route [51: badkup ¥
@ Service (0) =
ok RAZ (1)
@ Incoming Call Route () s
$2) wanPart (0) Time Prafile a e (Ut of Haurs Route <Nones |
= Directory (0) 1
£7% Time Profile (0]
Firewall Profile (1) T
@i s p——— B e Gn
&m Accourt Code (0) 11 11 Dial Emergency 0
S Licenss (30) a1l a1l Dial Emergency 0 Remove
i Tunnel (1) oy an Dial 31 o =
3 User Rights (10} 1 1N'192,168.31.194" Dial 3K1 17
[ Auto Attendant (O} o M Dial 3K1 o
o RN u Dial 31 0
“ofu ESIL System (1)
Altstnate Route Priority Level |3 v l
Alternate Route Wait Tme (30 % | Alternate Route 51: backup ~| =]
- : gt N ced e
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Assuming the primary route is in-service, the number passed from the short code used to access ARS
(e.g., 6N in Section 5.5) can be further analyzed to direct the call to a specific Line Group ID. Per
the example screen above, if the user dialed 6-1-613-967-5205, the call would be directed to Line
Group 17, the SIP Line configured and described in these Application Notes. If Line Group 17
cannot be used, the call can automatically route to the route name configured in the Additional
Route parameter in the lower right of the screen. Since alternate routing can be considered a
privilege not available to all callers, IP Office can control access to the alternate route by comparing
the calling user’s priority to the value in the Alternate Route Priority Level field.

The following screen shows an example ARS configuration for the route named backup with ARS
Route ID 51. Continuing the example, if the user dialed 6-1-613-967-5205, and the call could not be
routed via the primary route 50: Main described above, the call will be delivered to this backup
route. Per the configuration shown below, the call will be delivered to Line Group 1, using an
analog trunk connecting the Avaya IP Office to the PSTN as a backup connection. In this case, the
originally dialed number (sans the short code 6) will be dialed as is through the analog/PRI trunk to
the PSTN.

IP Offices E backup el X[ v <>

& BooTP(7) Name Time Profile
~{# Operator (3) > -
=I5 IPOffice_1 Main ARS Route Id | Secondary Dial bone:

@ 5 - -

aRE |

|

iin Route Name backup |SystemTane v
== Control Unit (4) - 2

i f Extenzian (40) Dial Delay Time System Default (4) 4| Check User Cal Barring
H User (31) B

+-ia Hunt@roup £1)

H :é‘ ghm c;g)e (58) In Service Out of Service Route [ <hone> v/
ervice 5 _

o RAS(D l

) Incoming Call Route (9) - ]

4§ wranpart () Time Profile — s OUt of Hours Route | <hione »

* = Directory (0) l

£33 Time Profile (0}

(@) Firewall Profie (1)

N Roue () ode Telephare Murber Festue Line Group 1D

* &m fccount Code (0) 1t alL Dial Emergency o
| %, License (30) 911 911 Dial Ernergency 0
i Tunnel {0 M 1 Dial o B
ifia User Rights (10)
* g Adto Attendant ()
eEEE)

f® E911 System (1)

| e Alternate Route | <Mone> | =

. " .- Help

In the testing associated with the configuration, calls were successfully delivered to SIP Line 17 via
the primary ARS route 50: Main or to the analog/PRI trunk via the backup ARS route shown above.
When the primary route experiences a network outage, Avaya IP Office successfully routed the call
via the backup route.
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5.9. Privacy/Anonymous Calls

For outbound calls with privacy (anonymous) enabled, Avaya IP Office will replace the calling party
number in the From and Contact headers of the SIP INVITE message with “restricted” and
“anonymous” respectively and enable privacy:id. On the other hand, by default Avaya IP Office will
send the P-Preferred-Identity (PPI) or can be configured to use the P-Asserted-Identity (PAI) header
to pass the actual calling party information for authentication and billing. For the compliance test,
Rogers does not use ether PPI or PAI for the purposes of privacy.

5.10. SIP Options

Avaya IP Office sends SIP OPTIONS messages periodically to determine if the SIP connection is
active. The rate at which the messages are sent is determined by the combination of the Binding
Refresh Time (in seconds) set on the Network Topology tab in Section 5.1 and the
SIP_OPTIONS_PERIOD parameter (in minutes) that can be set on the Source Number tab of the
noUser user. The OPTIONS period is determined in the following manner:

*+ Ifno SIP_OPTIONS_PERIOD parameter is defined and the Binding Refresh Time is 0,
then the default value of 44 seconds is used.

*+ To establish a period less than 42 seconds, do not define a SIP_OPTIONS PERIOD
parameter and set the Binding Refresh Time to a value less than 42 secs. The OPTIONS
message period will be equal to the Binding Refresh Time.

* To establish a period greater than 42 seconds, a SIP_OPTIONS_PERIOD parameter must
be defined. The Binding Refresh Time must be set to a value greater than 42 secs. The
OPTIONS message period will be the smaller of the Binding Refresh Time and the
SIP_OPTIONS_PERIOD.

To configure the SIP_OPTIONS PERIOD parameter, navigate to User = noUser in the
Navigation / Group Panes. Select the Source Numbers tab in the Details Pane. Click the Add
button.

IP Offices =] NoUser: e R A
& BoOTP (7) Dlane Eenon ilihicor: [Veicamed 1] oD || Shortcodes Telephoryy | Forwarding | Dial In | Yoice Recording | Button Programming || Menu Programming | Mobility | Phone Manager Options || Ho ¢ &
% Operator (3) & Anslog 0404 0404 = - T
1 §roigital 0403 0409 Source Number
&-Fas 0407 0407
it Remave
0402 Edit
0410
uuuuuuu
& Incoming Call Routs (3)
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At the bottom of the Details Pane, the Source Number field will appear. Enter

SIP_OPTIONS_PERIOD=X, where X is the desired value in minutes. Click OK.

& BoOTR(7)
¢ Operator (3)
=5 IPOffice_1
57 System (1)
47 Line (3)
< Control Unit (4)
& Extension (40)
i
3§ HuntGroup (1)
% Shart Code (53)
@ Service (0}
o RAS (1)
P Incoring Call Route (3)
4 wanpart (0
% Directary (0]
73 Time Profile (01
(@) Frewall Profile (1)
R 1P Route (3)
&m Account Code (0)
s, License (30)
& Tunnel (0}
§5 User Rights (10}
188 Auto Attendant (0}
¥ ARS (2)
fx E311 System (1)

Harne

Franalog 0404

§r0igital 0408

Frrax 0407

§H323 0401

§H323 0402

SmremoteManager

- SIP

= Softphone 0403
Woicemail 0415

IP Offices User E

Extension

0404
0409

0410
0403
0415

NoUser:

Source Number

New Source Mumber

ek -E I X[ v«

Lser | Voicemail | DWD | ShortCodes | Source Mumbers | Telephony | Forwarding | Dial In | Voice Recording | Button Programming | Menu Programming | Mobility | Phone Manager Options | Hu € &

Add..,

Remove

Edit...

‘Suurce Number [stp_opTiONS PERIOD=2

==

Cancel

The SIP_OPTIONS_PERIOD parameter will appear in the list of Source Numbers as shown
below. For the compliance test, an OPTIONS period of 1 minute was desired. The Binding
Refresh Time was set to 60 seconds (1 minute) in Section 5.1. The SIP_OPTIONS_PERIOD
was set to 2 minutes. Avaya [P Office chose the OPTIONS period as the smaller of these two
values (1 minute). Click the OK button.

K BOOTP (7}
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=% 1POFfice_1
5 System (1)
5 Line (3)
= Cantral Unit {4)

A Extension (40)
i
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@ Short Code (55)
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& wanPort (0)
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£ Time Profile (0)
@ Firewall Profils (1)
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4 User Rights (10)
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§H323 0401
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-8 X[ vl<]>
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Edit,..
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User || voicemail | OND | ShortCades Telephony || Farwarding | Dial In || oice Recording || Button Programming | Menu Programming | Mobility | Phone Manager Options | Hu ¢ »

0404 v Y o
0409 Source Mumber
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0401
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3

[ o | conel |[ hei

5.11. Save Configuration

Navigate to File > Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.

HV; Reviewed:

SPOC 4/15/2013

Solution & Interoperability Test Lab Application Notes
©2013 Avaya Inc. All Rights Reserved.

23 of 27
RBSSipTrkIPO81




6. Rogers Business Solutions SIP Trunking Configuration

Rogers Business Solutions is responsible for the configuration of Rogers Business Solutions SIP
Trunking service. The customer will need to provide the IP address used to reach the Avaya IP
Office at the enterprise. Rogers Business Solutions will provide the customer the necessary
information to configure the Avaya IP Office SIP connection to Rogers Business Solutions. The
provided information from Rogers Business Solutions includes:

IP address of the Rogers Business Solutions SIP proxy/gateway.
Supported codecs.
DID numbers.

IP addresses and port numbers used for signaling or media through any security devices.

» > » »

7. Verification Steps

The following steps may be used to verify the configuration:

*+ Use the Avaya IP Office System Status application to verify the state of the SIP connection.
Launch the application from Start = Programs - IP Office - System Status on the PC
where Avaya IP Office Manager was installed. Select the SIP line of interest from the left
pane. On the Status tab in the right pane, verify that the Current State is Idle for each
channel (assuming no active calls at present time).

IP Office System Status

Ahaout

Status | |Utization S it Alarms | Registration

SIP Trunk Summary

Peer Domain Marme: 104058514

Resolved Address: 19216831194

Line Mumber: 17

Murmber of Administered Channels: 10

Mumber of Channels in Use: a

Administered Compression: Auto

Silence Suppression: Off

SIP Trunk Channel Licences: Unlimited O o %
SIP Trunk Channel Licences in Use: ]

SIP Device Features: REFER {incaming and outgaing)

ect Caller IC Other Party  Directior Round T Rece;

Dialed O on Call of Call  Delay  Jitter

Ide |1day ...
Idle  |1day ...
Idle [1dav...
Ide |1day...
Idle [1day ...
Ide |1day...
Idle |1 day ...
Ide |1day...
Idle |1 day ...
Idle [1day ...

E=R= RN = R R R SRR

—
=]

Trace Trace All ” Pause ” Fing ] Call Detailz Print. .. ” Save As...
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*+ Select the Alarms tab and verify that no alarms are active on the SIP line.

AVAYA IP Office System Status

Help Snapshot  LogOff  Exit  About

B System

K & Alarms (1)

B Extensions (10)

B Trunks (5)
Lines:1-4
»

Active Calls

Skatus  Ukilization SUMmary Alarms Reqgistration

Alarms for Line: 17 SIP 10.10.98.14

Ocourrences Errar Description

E Resources
E Voicemail
E IP Networking

* Verify that a phone connected to the PSTN can successfully place a call to Avaya IP Office
with two-way audio.

* Verify that a phone connected to Avaya IP Office can successfully place a call to the PSTN
with two-way audio.

8. Conclusion

Rogers Business Solutions SIP Trunking passed compliance testing. These Application Notes
describe the procedures required to configure the SIP connection between Avaya IP Office and the
Rogers Business Solutions SIP Trunking service as shown in Figure 1.

9. Additional References

[1] TP Office 8.1 Installation, Document number 15-601042 Issue 26j, 19 Sep 2012

[2] IP Office 8.1 Manager 10.1, Document number 15-601011 Issue 290, 03 Aug 2012

[3] IP Office 8.1 Administering Voicemail Pro, Document number 15-601063 Issue 27b, 05 June
2012

Product documentation for Avaya products may be found at http://support.avaya.com. Additional IP
Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/

Product documentation for Rogers Business Solutions SIP Trunking may be found at:
http://www.rogersbusinesssolutions.com/sip-trunking/
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Avaya and the Avaya Logo are trademarks of Avaya Inc. All trademarks identified by ® and ™
are registered trademarks or trademarks, respectively, of Avaya Inc. All other trademarks are the
property of their respective owners. The information provided in these Application Notes is
subject to change without notice. The configurations, technical data, and recommendations
provided in these Application Notes are believed to be accurate and dependable, but are
presented without express or implied warranty. Users are responsible for their application of any
products specified in these Application Notes.

Please e-mail any questions or comments pertaining to these Application Notes along with the
full title name and filename, located in the lower right corner, directly to the Avaya DevConnect
Program at devconnect@avaya.com.
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